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6 
 

Definitions for the SSI Sidewalk Profiler 
Ride Index Number  
A ride index number is the result of an equation to generalize and relate all surfaces based on their 
specific ride quality. Ride numbers can be in the form of Profile Ride Index (PRI) and the International 
Roughness Index (IRI). 
  
Bump and Defects 
A bump or defect is a deviation over a standardized length, such as 25 feet. Bump detection simulates 
the response of a straight edge on the physical surface. Bump height is the limit of this deviation. 
Bump heights and lengths should be specified in the contract of the project. 
 
Scallop 
Scallops are the deviation of the profile from the center line of the profile’s moving average. The 
scallops have a minimum height and width (longitudinal length), so that rapid increases of profile 
height will not be counted towards the ride number. If an event does not meet the minimum 
requirements to be a scallop, it can still be localized roughness. 
  
IRI 
The International Roughness Index was created by The World Bank to standardize the smoothness of 
roads. IRI is based off of the quarter car simulation which replicates the ride quality of the road felt 
by the user. The value of IRI is filtered through the quarter car simulation but the equation for IRI is 
essentially: 
 

   𝐼𝑅𝐼 =  
𝑇𝑜𝑡𝑎𝑙 𝑉𝑒ℎ𝑖𝑐𝑙𝑒 𝑆𝑢𝑠𝑝𝑒𝑛𝑡𝑖𝑜𝑛 𝑀𝑜𝑡𝑖𝑜𝑛

𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑇𝑟𝑎𝑣𝑒𝑙𝑒𝑑
         𝑈𝑛𝑖𝑡𝑠 = [

𝑖𝑛

𝑚𝑖
,

𝑚

𝑘𝑚
]  

 
 
IRI Defects (Localized Roughness) 
Defects on the surface, sometimes referred to as “areas of localized roughness,” can be determined 
through IRI. By changing the threshold of the IRI (in/mi, m/km) and the base length of the defect, the 
Profiler software is able to find the locations of the defects. A defect location occurs when the 
threshold is exceeded for the specified base length. 
 
Profilograph Defects 
Defects, bumps and dips can be found through the Profilograph defects option. This option is 
dependent on the height and width of the bump or dip. With the two parameters of height and width 
entered, a Profilograph straightedge simulation will determine the 25 foot sections of the profile that 
exceed these parameters.  
 
PRI 
Profile Ride Index is the measure of the profile deviations from the centerline. By inputting 
information such as the blanking band, minimum scallop height and width, and the scallop resolution 
the PRI is calculated. The scallops are the individual deviations from the profile. If an event in the 
profile does not exceed the minimum height or width for scallops, the event is not counted toward 
the final PRI number. The PRI is dependent on the segment width for its calculations when a full 
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segment is collected. In this case the segment length will be the distance traveled in feet. The equation 
for PRI is: 
 

   𝑃𝑅𝐼 =  
𝐶𝑜𝑢𝑛𝑡𝑠 𝑓𝑜𝑟 𝑅𝑜𝑢𝑔ℎ𝑛𝑒𝑠𝑠 𝑖𝑛 𝑖𝑛𝑐ℎ𝑒𝑠 × 5280

𝐷𝑖𝑠𝑡𝑎𝑛𝑐𝑒 𝑇𝑟𝑎𝑣𝑒𝑙𝑒𝑑 𝑖𝑛 𝐹𝑒𝑒𝑡
 

 
Point Events 
Point events, also known as notes, are items or features at specific locations that the user wants to 
store and identify within the data.  Point notes can also be used to identify sections of the sidewalk 
that do not meet specifications through the height or width requirements.  
 
Segment Events 
Segment events, also known as intervals, are interruptions or important structures that occupy 
intervals of the sidewalk. Segment events include crosswalks, driveways, sections without sidewalks, 
curb ramps, bus stops, and pauses which are related to the profile.  
 
Odometer 
The odometer can be found in two places within the SSI Profiler program, both under the collection 
window.  The initial odometer is on the home screen of the collection window. This odometer will be 
in the form of a separate window. The second odometer aids the user in adding and editing events 
after a collection is ended.  
 
Pause 
A pause is a section of the profile that can be excluded from the report or specifically viewed to 
determine its profile ride number (IRI, PRI, etc.) 
 
Profile Collection 
When a data collection begins, the profiler will collect the profile of the sidewalk. Once the profile 
collection is started, events can be entered in the form of point or segment events.  
 
Interval Collection 
An interval collection is the process of adding a segment event to the collection. To add a segment 
event, select the ‘Start Interval’ icon during a collection. After the collection the user will be able to 
apply a type of segment event and edit the stationing before saving the collection.  
 

Sidewalk Profiler Hardware 
Switches 
The profiler has two switches located on the top of the electronics housing. One switch is for the 
power of the profiler while the second switch is used to turn on the lights.  When the profiler is turned 
on, the battery meter will illuminate. The lights will only work if the profiler is turned on or charging.  
Laser 
The laser mounts to the front of the profiler body and is connected to the electronics via two cables. 
Ensure there are no obstructions between the laser and the ground. When powered on and 
connected to the electronics the “POWER” and “LASER” LEDs will illuminate though the “RANGE” LED 
and beam on the ground will only be visible when collecting data.  
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Lights 
The lights on the profiler are located at the front and rear of the electronics housing. To turn on the 
lights, the profiler must be powered on or connected to the charger and the switch for the lights must 
be on.  
Battery Meter 
The battery meter not only illustrates the amount of power left in the battery, but it also indicates 
that the profiler is turned on. 
Charging 
To charge the profiler, connect the color coded charging terminals to the corresponding terminal color 
on the back of the profiler, or if equipped, simply mate the charging plug to it’s receptacle. The LED 
on the charger will turn red when there is a load on the circuit due to charging. The LED will become 
green when charging is complete. In some cases the charger may need to be plugged into to 120v AC 
before connecting to the profiler. 
Adjusting the Right Wheel 
The right wheel is adjusted by loosening the set screw at the top of the dovetail assembly. It is 
important to not over-tighten the set screw because it may damage the nylon insert. The position of 
the right wheel is crucial to the profiler’s stability. For optimum performance position the center of 
the dovetail 5 inches from the rear of the electronics housing. 
 
Tires and Pressure 
Prior to collection inspect the tires to make sure they are aligned with each other. Most units are 
equipped with foam tires. For pneumatic tires, the ideal tire pressure is listed on the side. For the 4-
ply tires the maximum pressure is 60 pound per square inch (psi). 
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Calibration Procedures    
 

 
 
 
 
 
Height Calibration 
To perform a height calibration, the walking profiler needs to be placed on a level surface.  Mark the 
locations of the fixed left side wheels on the ground and begin the calibration process.  
 
 

 
 

Figure 1: The calibration menu which appears after the “Calibrate” icon is selected.   

Figure 2: System on a level surface with the position of the wheels marked.  
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Proceed to press the Height Calibration button on the initial “Calibration” Menu. 
 
 

 
 
 
 
 
 

 
 
 
 

Figure 3: The first window of the height calibration instructing the operator to place the 
walking profiler on level ground and set the brake.  

Figure 4: Brake set and profiler in place before hitting the next button.  
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With the brake set, line up the main wheel axels with the marks on the ground.   

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Press “Next” in the current calibration window.  
 

 
 

 
 
 

 
After the first phase of the height calibration the walking profiler must be turned around 180 
degrees and have its left-side wheels swap positions. Each wheel should be over the exact spot 
the other wheel was over in phase one.  When the walking profiler is in position, select next.  

 

Figure 6: Calibration window after the first phase of the height calibration.  

Figure 5: System set in its first phase position with axle of wheels lined up with marks 
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Press “Next” in the current calibration window.  
 

 

 
 
 
 
 
 

Figure 8: Window after a successful calibration.  

Figure 7: Positioning for the second phase of the calibration.  

 Figure 2: The device position for initial height calibration procedure. 
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Distance Calibration 
Calibrate the distance readings of the walking profiler by measuring out 528 ft (160 meters) with a 
rolling wheel measuring device. The calibration track should be as straight and level as possible.  Once 
the test track is prepared, start the calibration procedures through the Calibrate icon in the Collect 
window. Select Distance Calibration and follow the steps precisely to complete a successful 
calibration.  
 

 
 
 
 

Set the length of the calibration track. The units can be changed by clicking on the feet (ft) symbol and 
choosing the appropriate units. After the length of the track has been entered, select accept. 

 

 
 
 
 
 
Once the walking profiler’s front wheel is on the beginning of the track, select next and push the 
device until the front wheel is at the end of the calibration track as indicated in the collection window. 

 

Figure 9: The initial window of the distance calibration for setting the track legth.  

Figure 10: The instructions for the distance calibration are shown above.  
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Displayed are the number of encoder counts, the length of the track that was entered in the 
previous window and the estimated distance traveled based on the last calibration.  

If the estimated distance does not match the “Calibrated to” distance, it could be that the 
system has never been calibrated, the last calibration was an improper, or the system had a 
hardware/software update (None of which are a problem). 

When the end of the track is reached, select next.  

 
 
 
 
 
 
 
 
 
 

 

Figure 11: This window shows the distance calibration summary. 
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Closed Loop Calibration 

 

 

Figure 12: Window showing the two options under the Closed Loop Calibration. 

 
 

 

 

 

 

 

 

 
 

 

 

Both the Profile Slope and Cross Slope calibrations should be performed on a uniform surface 
(ideally on a slab or an asphalt section). Do not start calibration with the wheels over a crack or 
change level from slab to slab during calibration. When calibrating a new device, the height and 
distance calibrations must be performed prior to either closed loop calibration. 

The distance of the track should be between 10 and 30 feet (3 and 9 meters).  This manual uses a 
25ft (7.67m) segment for illustration. 

Note: Base length (length from back wheel to laser) must be entered before calibrations can be 
performed. This value typically ranges between 17 to 18 inches.  
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Profile Slope Calibration 
Place system laser at start of track. 

 

Figure 13: First window of the Profile Slope Calibration. The initial negative distance 
indicates the length between the laser and back wheel. Proceed to push system to end of 
track.  

Figure 14: Calibration window with system at end of track. When the end of the 
track is reached, select next. 
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     With the system facing the opposite direction and laser at the end of the track, where the back 

wheel ended, push system back to initial starting point. The main wheels should go over the same 
line. The distance traveled will be reversed. Stop when the onscreen “Current Distance” shows 0.00 
feet. 

Figure 15: Calibration window indicating operator to turn the system around, align the MAIN 
wheels with the track, and press “Next”. 
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Figure 16: Calibration window indicating end of return close loop run. Press “Next”. 

 

Figure 17. Calibration window calculating results. 
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Cross Slope Calibration 
 

 

 

Figure 18: Window indicating completion of Profile Slope Calibration. 

 

Figure 19: Closed Loop Calibration window with “Cross Slope” selected. 
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The first two steps are identical to the “Profile Slope” Calibration 

 

 

 

 

 

 

 

 

Figure 20: First window of the Cross Slope Calibration. The initial negative distance indicates 
the length between the laser and back wheel. Proceed to push system to end of track. 

 

Figure 21: Calibration window with system at end of track. When the end of the track is 
reached, select “Next”. 
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The Cross slope Calibration is a wheel base run, meaning the system goes over same surface. Align 
the outside wheel over the same track the main wheels went over.  

Figure 22: Calibration window indicating operator to turn the system around and align the 
OUTSIDE wheels with the track, and press “Next”. 
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With The system facing the opposite direction, push system back to initial starting point. The OUTSIDE 
wheels should go over the calibration line. The distance traveled will be reversed. Stop when the 
onscreen “Current Distance” shows 0.00 feet. 

 

 

 

 

 

 

Figure 23: Calibration window indicating end of return close loop run. Press “Next”. 

 

Figure 24: Window indicating completion of Cross Slope Calibration. 
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Collection 
Connecting Device 
Connection of the profile system is through the serial or usb port located of the Toughbook computer 
supplied. Once connected with the Profiler V3 program, open and the power switch of the profiler on. 
The Program should display ‘Profiling System Hardware Connected.’ 
 
Power On 
The Profiler is powered on when the battery meter light is on. If the meter light is off, check the switch 
for the power or charge the battery. Always turn on the device before opening the SSI Profiler 
program.  
 
Opening Profiler V3  
To open the Profiler V3 program select the SSI Profiler icon on the desktop or select the same icon by 
navigating to the folder: C:\Program Files\SSI Profiler 3\SSI.Surface.Roads.Profiler.App 
 
Hardware Found 
When the profiler is turned on, properly connected to the operator computer, and Profiler V3 is 
running, the software should indicate “hardware found”. If hardware is not found and these 
requirements are fulfilled, check the connections and profiler system power. If the profiler was 
powered on after the program was opened, close the program and reopen it with the profiler 
powered on. If problem persists, contact SSI Customer Support for assistance.  
 
Navigate to Collection Window 
Once hardware is found, the ‘Collect’ icon on the shortcut bar or View>Collect will be available. To 
enter this section, just left click on Collect. 
 
Troubleshooting 
If the system displays an error asking to reconnect the hardware, shut down the Profiler program and 
reopen SSI Profiler, keeping the power to the profiler on. If this does not solve the problem, power 
down the walking profiler and close the SSI Profiler program. After 10 seconds, turn on the walking 
profiler and reopen SSI Profiler.  
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Odometer 
The odometer can be used to measure distances with the profiler. The odometer is only as accurate 
as the currently saved distance calibration.  
 

 
 
 

File Name Hardware Connected 

Speedomete
r 

  Status & GPS               Collect Icon 
   Odometer 

Short-cut 
Bar 

 

Hide 
Bar 

Figure 26: The odometer of Profiler V3. 

Calibrate 
 

 

Diagnostics 

 Figure 25: The Collect Window 



 

25 
 

An odometer is also available when editing events so that the operator can find the locations of the 
events that were inputted, or to add additional events.  
  
 

 
 
 
 
 
 
 
 
 
 
 
Diagnostics 
The diagnostics tool contains vital information for early stages of 
troubleshooting. The diagnostic window is color and number coded 
to determine problems. When no problems are encountered, the 
diagnostic will have all zeros and green icons. If SSI Customer 
Support asks for the diagnostic health string, it is located in the text 
box at the top of the window. 
 
 
 
 
 
 

Figure 28: The Diagnostic Window 
above shows a healthy Profiler system. 

Odometer 

Figure 27: Odometer in Event Editing 
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GPS Details 
When the collection window is opened, the GPS icon will be below the Collect icon. The GPS details 
show the number of satellites and the NMEA String of the data used to calculate position. 
 

 
 
 
 
 
 
 

Collect 
Collection Information 
The collection information can be accessed by selecting the Collect icon in the Collect Window. This 
window is prior to starting a collection. 
 

 
 
 
 
 

Figure 29: GPS Details window 

Figure30: Collection Information window 
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Start Cross Street 
The Start Cross Street is the transverse street which marks the location the profiler at the starting 
point of the collection. This street input is not the Collection Street.  
  
End Cross Street 
The End Cross street is the name of the transverse street where the profiler ended the collection.  
 
Collection Street 
The Collection Street is the street where the profiler tested the sidewalks. 
 
Date Tested 
The date tested is the day that the smoothness or sidewalk testing is occurring.  
 
Section Notes 
Section notes is the information related to the starting point and the project such as landmarks and 
the visible condition of the pavement.  
     
Weather Conditions  
The weather conditions are important for the expansion and contraction of the pavement and the 
profiling equipment hardware. Keep this information updated if comparing of collections taken at two 
different times.  
 
Move Profiler to Start of Track 
The profiler’s laser should be on the position of the starting point when ‘Begin’ is selected from the 
Collection Information window. The collection will start when ‘Begin’ is selected. The profile collection 
will begin, not a segment collection.  
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During Collection 
The collection should be started with the laser above the starting point and ended with the left rear 
wheel over the ending point. Keep this suggested starting point to keep consistent data collection 
lengths.  
 
File Name 
In the bottom left corner is the location of the file name. If the current file is unsaved, then the name 
of the file will be “New File.” If that file has data associated with it, the name will have asterisk after 
it (New File*). 
 

Figure 31: The initial view of a new collection. 
An unsaved file 
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Figure 32: A collection without events selected. 

Figure 33: A collection with a point event at 0+14.3 feet. 
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Add Notes (Input After Run) 

 
 

Add Note 
The “Add Note” feature can add events to the reports to be viewed during post analysis. When “Add 
Note” is selected during collection, the user will not add the note until the current run has ended. 
 
Interval Collections (Input After Run) 
Interval collections are used when the user encounters curb ramps, crosswalks, driveways, no 
sidewalk, bus stops or other events. Information about the event can be entered in the text box at 
the bottom of the window. Segment events are started during a collection by selecting ‘Start Interval.’ 
At this time the status bar will turn yellow and will display the stationing of where the interval was 
started. To end the interval, select ‘End Interval.’ Segment events can be added and edited after the 
collection is ended, before the run is saved. Adding additional segments is where the odometer is 
useful. 
 
Event Templates 
Once the run has ended the user can edit any Notes or Intervals. Selecting a template from the 
templates list (on the right side of the screen) will automatically insert the template into the note. To 
add, edit, or remove templates click the “Event Templates” button before the start of a collection. 

Figure 34: A collection with a segment interval being profiled. The note below the 
yellow status shows where the segment event started. 
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Event Keys 
The user can configure event keys in order to insert events that will be prefilled with a template during 
a collection. To configure event keys click the “Manage Event Keys” button before the start of 
collection. To map a new event click on the button under the Keys column. A popup will prompt the 
user to press any key. Once the key is mapped the user can change the event, template, or event type 
that will be tied to that key. See Figure 35. Just press (do not hold) any mapped key during a collection 
to insert the event. If the event is an Interval, the collection will automatically switch to Interval mode. 
Pressing any key that is tied to an Interval event while in Interval mode will switch the collection back 
to normal but will not insert the event (same as clicking “End Interval”). 
 

 
 

 
Editing a Collection  
After a collection which included interval (segment) or point events, the final step before saving will 
be to add or edit events. By default the program will take the user to this screen at the end of a 
collection. The operator can use the odometer on this screen with its reset button to evaluate each 
event position again or to add new events where the stationing is unknown. The two types of events 
are described below. When the operator is finished with the editing of the events, select “Save Run.” 

Figure 35:  Example of Event Key Configuration 
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At this time, the program will display the home screen for the collection window. More runs may be 
collected, or collections may be viewed under reports.  
 
New File 
After collecting a file and before collecting another run, save the current collection and open a new 
file. This will prevent data from being overwritten or unorganized.   
 
Point Events 
Point events are the sections of the sidewalk that do not meet specifications through the height or 
width requirements.  
 
Segment Events 
Segment events are interruptions or important structures that occupy intervals of the sidewalk. 
Segment events include crosswalks, driveways, sections without sidewalks, curb ramps, bus stops, 
and pauses which are related to the profile. Segment events are started during a collection by 
selecting ‘Start Interval.’ At this time the status bar will turn yellow and will display the stationing of 
where the interval was started. To end the interval, select ‘End Interval.’ Segment events can be added 
and edited after the collection in ended, before the run is saved. Adding additional segments is where 
the odometer is useful. 
 
Key Press Notes 
Key Press Notes are the user inputted notes that can be entered for each event. The notes are entered 
through the keyboard, hence their name, key press notes. These notes will appear on the sidewalk 
report next to the event type and the event’s location through GPS and stationing.  
 
Odometer 
The odometer can be found in two places within the SSI Profiler program, both under the collection 
window.  The initial odometer is on the home screen of the collection window. This odometer will be 
in the form of a separate window. The second odometer aids the user in adding and editing events 
after a collection is ended.  
 
Pause 
A pause is a section of the profile that can be excluded or specifically viewed to determine its profile 
ride number (IRI, PRI, etc.) 
 
Profile Collection 
When a data collection begins, the system will collect the profile of the sidewalk. Once the profile 
collection is started, events can be entered in the form of point or segment events.  
 
Interval Collection 
An interval collection is the process of adding a segment event to the collection. To add a segment 
event, select the ‘Start Interval’ icon during a collection. After the collection the user will be able to 
edit the event and apply a type of segment event before saving the collection.  
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Finalizing a Collection 
Saving the File 
After a collection is completed, the file can be viewed in reports or saved. To save the file, selecting 
File>Save or through Ctrl+S on the keyboard. These actions will open Windows Explorer for the file to 
be saved. If the file is not saved and the operator navigates away or tries to close the program, Profiler 
V3 will ask the operator to save the file.  
 
 Default Naming Convention 
 The default naming convention for SSI Profiler is in the form of: 
     YYYYMMDDTTTT.  
 

An example of this is: 201212021635 
This name means the file was saved in the year 2012, December 2nd, at 4:35pm. 

 
Opening a New File 
To open a new file after a collection, select File>New or Ctrl+N on the keyboard. When a new file is 
opened, the lower left corner of Profiler V3 will display “New File.” 
 

Mapping 
The mapping feature can be used to navigate to defects in the profile based on the GPS coordinates. 
Mapping can be used in trace view or through the compass and distance readout on the Mapping 
window. To navigate to a defect using Mapping:  

1) Open a file in SSI Profiler with defects 
2) Open the Mapping window through the shortcut bar or through 

View>Mapping. 
3) At the top, select a run and click on the “Navigate To” icon. 
4) The user may choose to navigate to a defect, station, segment, or a specific 

GPS coordinate. Choose the option from the drop down menu. Select a 
location and click on the green Start Navigation icon.  

5) Follow the instructions of the mapping to get to the destination.  
 
Note: A GPS signal and a collection using GPS is required to use Mapping feature. 
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Figure 37: A bump is selected about to be navigated to. 

Figure 36: The drop down menu for mapping shown 

Run being navigated along 
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Reports and Analysis 

 

Sidewalk Parameters 
The sidewalk parameters can be changed in the Settings under the Sidewalk Options tab. The non-
conforming parameters of the collected surface will be displayed in the report. Under this location 
the user may change: 
 
Maximum Running Grade 
Maximum running grade is the maximum value that the running grade cannot exceed. If this value is 
exceeded, the sidewalk report will list the sections of non-conforming sidewalk sections by GPS and 
stationing. 
 
Running Grade Cutoff 
Running grade cutoff is the value that is the maximum output allowed in the reports. Values over this 
threshold will be displayed as this maximum value in the report. 
 
 
Maximum Cross Slope 

Figure 38: Navigation is started. To reach the point the machine must move 429 feet West.  
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Maximum cross slope is the value that is the maximum output allowed in the report. If this value is 
exceeded, the cross slope report will list the non-conforming sidewalk sections.  
 
 
Cross Slope Cutoff 
Cross slope cutoff is the value that is the maximum output allowed in the reports. Values over this 
threshold will be displayed as this maximum value in the report. 
 
Slope Range Interval 
Slope range interval is size of the percentage range that the user desired to report running grade and 
cross slope.  
 
Minimum Length 
Minimum length is the shortest distance or length that can be reported for a given running grade or 
cross slope range. Most sidewalks will have a reporting distance of 24 inches based off of a wheelchair. 
   
Level Changes 
Level changes are classified as either 1:1 or 1:2 (rise:run) and can be up or down. Typical parameters 
for 1:1 and 1:2 level changes are .25” and .5” respectively. Note, these are minimum values. Larger 
changes in level can be reported as either 1:1 or 1:2 depending on their slope. 
 
Cracks 
Cracks are calculated based on the defined parameters of min length, max length, and min depth. 
 
Exclude Interval Types 
To exclude an interval type from the collection or reports select the report to be omitted. To exclude 
all interval types, select “Exclude All Sidewalk Interval Types.” 
 
When a setting is changed, select “Apply” to save the changes.   
 
Texture 
Texture (MPD) is reported per calculated sample, averaged over user defined interval, or as a 
maximum of the user’s interval length. 
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To view the results of a collection, navigate to the View>Reports tab or select Report from the shortcut 
bar. The top of the reports window has a refresh button, printer icon, pdf generating icon, the list of 
available reports and the zoom. To select a new report, select one from the drop down list, then select 
the refresh button.  
  
Sidewalk Report 
The sidewalk report shows the results of the running grades and bump heights of the sidewalk. The 
settings for the sidewalk profiler can be found in the Settings window under the Sidewalk tab. 
 
Key Press Notes 
Key Press Notes are the user inputted notes that can be entered for each event. The notes are entered 
through the keyboard, hence their name, key press notes. These notes will appear on the sidewalk 
report next to the event type and the event’s location through GPS and stationing.  
 
 

Figure 39: The sidewalk settings window 



 

38 
 

 
 
  
 

 
 
 

Figure 41: The collection data included in a sidewalk report.  

Figure 40: The top of a sidewalk report 
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Single Trace 
The single trace report shows the physical profile and the profile number of the sidewalk. There will 
also be information about the defect height, length of collection, file name and calibration 
information displayed.  
 
Summary Report 
The summary report shows the location of the collection and the information pertaining to the 
sidewalks profile in tabular form. Information about the calibration, profile number, stationing, defect 
locations section location and section notes will be displayed.  
 
Cross Slope Report 
The cross slope report shows the changes in cross slope for the profile. The intervals that exceed the 
maximum slope will be displayed according to the preferences saved under the Sidewalk tab of the 
Settings window.  
 

 
 
 
  
 
 

Figure 42: The cross slope report displaying the transverse slope data.  
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Printing Reports 
To print the reports select either the printer icon or the pdf generator. If the printer was selected, 
input the correct settings of your local printer in the print options window that appears.   
 

 
 
 

Trace 
Choosing Tracks for Plotting 
To choose tracks for plotting in the trace window, select the check box next to the desired tracks.  
Once all of the necessary tracks are checked, select the refresh icon to view the tracks within the plot.  
Whenever a change is made by deselecting a track or checking a new track, select the refresh icon to 
have it appear in the trace.  If the refresh icon is not selected, the trace will not update and the changes 
will not be shown. Review the legend to verify that all of the selected tracks are shown in the plot.   
 

 
 
Refresh 
Refreshing the trace window is requiered whenever a change is made to the track selections.  The 
refresh icon is located at the bottom left of the Trace window. Select the refresh button and verify 
that the trace is accurate before a print is made.  

Figure 43: The Report Tools  

Figure 44: An example of the profile trace within the trace window.  
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Plot Options Icon 

 
 
 
 
The plot options window allows the user to alter the trace for their visual benefit. By selecting a threshold the 
operator can quickly find the locations with excess IRI.  The rendering mode options allow the operator to 
choose speed or high resolution traces. 
 

Profile/Continuous IRI 
The drop down menu allows the user to select two options of Profile and Continuous IRI.   
When Continuous IRI is selected, the operator may not choose the option to include run up and run 
out data.  

Figure 45: The plot options window  
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Figure 46: The drop down menu options of Profile and Continuous IRI are shown above. 

Figure 47: The Continuous IRI Plot options window.  
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Figure 48: The plot of the Continuous IRI trace.  

Figure 49:  The plot of the profile trace.  

This setting is chosen through the plot options. To change the plot to a Profile trace, select 
the Plot Options Icon and change the drop down menu settings to “Profile.” 

 

This setting is chosen through the plot options.  To change the plot to a continuous IRI graph, 
select the Plot Options Icon and change the drop down menu settings.  
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Exporting 
Matching, and Excel formats.   
The settings for each export feature are described below. For each of the exporting formats, a folder 
destination is required.  The Export feature can be found in the shortcut bar on the left hand side of 
the Profiler V3 window and in File>Export.   
 
Exporting to Sidewalk Format 
The operator can export to sidewalk format which formats the file to GIS compatible file types. The 
file types can be chosen through the check boxes. If a format is not needed, it may be unchecked and 
not exported. The files will be exported to the listed export location. This location can be changed 
through the “Browse” icon.  

 
 
 

Figure 50: The sidewalk export window 
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Export Location 
To select the folder destination, select ‘Browse’ and navigate through Windows Explorer to the 
desired folder. Once the folder destination is reached and selected, left click on ‘OK’ at the bottom of 
the window to save the folder location.  
 

 
 
 

Figure 51: The export window for exporting the data into ERD format.  

Figure 52: The export type.  
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Figure 53: Selecting a location to save the exported file. 

Figure 54: The export type drop down menu. 
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Exporting to ERD Format 

 
 
 
 
 
Station Extraction 
The operator has the option to only export certain sections of the data, based on the stationing set 
within the profiling data. To use this feature, select the check box near “Specify Station Numbers.” 
When the box is selected, the operator will be able to adjust the stationing numbers. The ‘Start’ 
stationing is the initial stationing where the exported file will begin, while the ‘End’ stationing is the 
point where the exported file will finish. These values can be adjusted by typing values into the box 
or by using the arrow keys to the right of the box.  
  
Filter Settings—High & low pass length 
The exported data file can have additional filters applied while being processed into the chosen 
format.  To not filter data, leave the filter lengths at the default value of 0.00 feet.  
 

High Pass Filter – The High Pass Filter will remove any trend in the data less that the chosen 
length. The length can be selected by typing the value in the box or by using the arrows to 
adjust the input.  

 

Figure 55: The ERD format export window with 
match tracks selected.  

Match Tracks is 
selected 
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Low Pass Filter – The Low Pass Filter will remove any trend in the data that is greater than the 
chosen length. The length can be selected by typing the value in the box or by using the arrows 
to adjust the input. 
 

Export Raw Data 
Selecting the Export Raw Data check box assures the operator that only unfiltered data collected from 
the profile will be exported into the chosen file. 
 

 
 
 
The entire data run is being exported since there are not station extractions.  

 
Match Tracks 
Selecting ‘Match Tracks’ exports all of the tracks associated with the lane file. For the three laser 
systems, this includes Track 1, 2 and the center trace. For the Profilograph files, the tracks are matched 
based on the settings entered prior to profiling. The label of the track number and stationing cannot 
be changed after collection. This feature does not have to be used for the sidewalk profiler system. 
 
 
Ignore Pauses 
Pauses are used when an obstruction comes into the profiling path or when a section of pavement is 
not to be profiled. Stationing is to remain constant and under the same file. Pauses can either be 
omitted or included in reports and exported file of the Profiler V3 software. To omit pauses from the 
exported file, select the check box, “Ignore Pauses.” Pauses are used as an interval or segment event 
for the sidewalk profiler system. 
 

Figure 56: An enlarged view of the ERD export window settings.  
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Exporting to PPF Format 

 
 
 
 
Station Extraction 
The operator has the option to export only certain sections of the data, based on the stationing set 
within the profiling data. To use this feature, select the check box near “Specify Station Numbers.” 
When the box is selected, the operator will be able to adjust the stationing numbers. The ‘Start’ 
stationing is the initial stationing where the exported file will begin, while the ‘End’ stationing is the 
point where the exported file will finish. These values can be adjusted by typing values into the box 
or by using the arrow keys to the right of the box.   
 
Filter Settings—High & low pass length 
The exported data file can have an additional filter applied while being processed into the chosen 
format.  To not filter the data, leave the filter lengths at the default value of 0.00.  
 

High Pass Filter – The High Pass Filter will remove any trend in the data that is less that the 
chosen length. The length can be selected by typing the value in the box or by using the arrows 
to adjust the input.  

 
Low Pass Filter – The Low Pass Filter will remove any trend in the data that is greater than the 
chosen length. The length can be selected by typing the value in the box or by using the arrows 
to adjust the input. 

Figure 57: The PPF export window. This window has the same settings as the ERD and 
Survey format.  
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Include Run up-Run out Data  
Some High Speed Profiling data files have Run Up and/or Run Out data associated with them, 
depending on the practice used to collect the data.  If this data exists in the data file, it will be included 
in the exported file if this box is selected.   
Run up data only exists in HSP (High Speed Profiler) data files if the operator selected a run up and/or 
run out distance in the initial stages of setting up a collection. The Run up and Run Out settings are 
found in the HSP collection software, in the last window before performing a collection.  
 
Export Raw Data 
Selecting the Export Raw Data check box assures the operator that only unfiltered data collected from 
the profile will be exported into the chosen file. 
 
Match Tracks 
Selecting ‘Match Tracks’ exports all of the tracks associated with the lane file.  For the three laser 
systems, this includes Track 1, 2 and the center trace. For the Profilograph files, the tracks are matched 
based on settings entered prior to profiling.  The number label assigned to the track and the stationing 
are settings that cannot be changed after collection. This feature does not have to be used for the 
sidewalk profiler system. 
 
Ignore Pauses 
Pauses are used when an obstruction comes into the profiling path or when a section of pavement is 
not to be profiled. During a pause distance is still collected but height data can be omitted. Pauses 
can be omitted or included in reports based on the selection in the Analysis Parameters window. 
Pauses are used as a segment or interval event for the sidewalk profiler system. 

 
 

Figure 58: An enlarged view of the optional settings 
when exporting in PPF format.  
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Exporting to PRO Format 

 
   General Settings 
 
Station Extraction 
The operator has the option to export only certain sections of the data, based on the stationing set 
within the profiling data. To use this feature, select the check box near “Specify Station Numbers.” 
When the box is selected, the operator will be able to adjust the stationing numbers. The ‘Start’ 
stationing is the initial stationing where the exported file will begin, while the ‘End’ stationing is the 
point where the exported file will finish. These values can be adjusted by typing values into the box 
or by using the arrow keys to the right of the box.   
 
Filter Settings-High Pass length 
The operator has the option to change the High pass filter length when exporting files to PRO format.  
A High Pass Filter removes all of the data trends below the filter length. The default length of the High 
Pass Filter is 200 feet. In order to export the data without filtering, the ‘Export Raw Data’ check box 
must be selected. See ‘Export Raw Data’ below.  
 
Export Raw Data 
Selecting the Export Raw Data check box assures the operator that only unfiltered data collected from 
the profile will be exported into the chosen file. 
 
Match Tracks 
Selecting ‘Match Tracks’ exports all of the tracks associated with the lane file. For the three laser 
systems, this includes Track 1, 2 and the center trace. For the Profilograph files, the tracks are matched 
based on settings entered prior to profiling. The label of the track cannot be changed after collection. 
This feature does not have to be used for the sidewalk profiler system. 

Figure 59: The export window when PRO format is selected.  
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Handle Pauses By: 
The paused sections within the collected data can be exported in two ways. Separate files can be 
created for each segment or the file can be exported with the paused sections included in one file. 
The difference in these two options is that creating separate file for each segment exports multiple 
files into the folder location, and the option of “Using pause events” exports one file to the folder 
location including all of the data. If the pauses were used to omit data because of pavement 
anomalies, use the option of ignoring the pauses.   
 

Details 
The details section of PRO exporting is the job specific information saved with the file, such as District 
Number, County Number, Reference Marker, Reference Offset, Highway Descriptor, Lane 
Descriptor, Certification Number, Certification Date, and Comments. This information is then saved 
with the PRO file to be displayed when the file is opened or printed using another program 
  

 
 
 
 

Figure 60: An enlarged view of the entire PRO export window.   

The right side includes two tabs of General Settings and Details. The General Settings tab 
contains the station extraction tool and filters. The Details tab allows the operator to input 
information about the project.   
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Exporting to Survey Format 
 

 
 
 
 
 
   
    
Station Extraction 
The operator has the option to only export certain sections of the data, based on the stationing set 
within the profiling data. To use this feature, select the check box near “Specify Station Numbers.” 
When the box is selected, the operator will be able to adjust the stationing numbers. The ‘Start’ 

Figure 61: The Details tab contains information about the project. 

Figure 62: Exporting in Survey format window 
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stationing is the initial stationing where the exported file will begin, while the ‘End’ stationing is the 
point where the exported file will finish. These values can be adjusted by typing values into the box 
or by using the arrow keys to the right of the box.   
 
Filter Settings 
A High and Low Pass filter is optional when exporting to survey format. The exported data file can 
have an additional filter applied while being processed into the chosen format.  To not filter the data, 
leave the filter lengths at the default value of 0.00 feet.  
 

High Pass Filter – The High Pass Filter will remove any trend in the data less that the chosen 
length. The length can be selected by typing the value in the box or by using the arrows to 
adjust the input.  

 
Low Pass Filter – The Low Pass Filter will remove any trend in the data greater than the chosen 
length. The length can be selected by typing the value in the box or by using the arrows to 
adjust the input. 

 
Profile Data Sampling Interval 
The sampling interval is the distance between readings of the SSI survey system. The default length 
of this interval is 1 inch. This feature allows other intervals of 6 and 12 inches to be implemented, 
depending on the accuracy needed in the surveying program.  
    

 
 
 Figure 63: The enhanced view of the Survey format export window 
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Exporting to Excel Format 
Exporting the profile data to excel gives the operator versatility and efficiency when an adjustable 
numerical printout is needed.  
 

 
 
 
 
Export to Comma Delimited File 
The Comma Delimited file shows the track number, segment number, start and end stationing and 
the ride number selected in the Analysis Parameters.  
 

Figure 64: Exporting the data into Microsoft Excel format 
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Export to Template 
To choose a SSI Excel Template, select “Export to Template.” 
 

 
 

Figure 65: An example of exporting the data into Excel. 

Figure 66: The types of excel formats are listed in the 
template drop down menu.  

Types of excel formats to 
export the collected data into. 
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Defects Template 
The Defects Template shows the locations and heights of the defects and information about the file 
in spreadsheet form. 
 
IRI Template 
The IRI Template gives information on the IRI statistics along with the defect locations and heights.   
 

 
 
 
 
PRI Template 
The PRI Template lists the PRI for each track along with the bump heights, locations and settings. 
 

Figure 67: An example of the IRI Excel template 
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IRI Unmatched 
The IRI Unmatched Template shows the calculated IRI for each track along with the defect heights, 
defect locations and settings.  
 
PRI Unmatched 
The PRI Unmatched Template shows the calculated PRI for each track along with the bump heights, 
locations and settings in spreadsheet form.  
 
Exporting to Google Earth 
The export to Google Earth feature allows operators with Google Earth installed on their computers 
to view the test data in the real environment. The view of the Google Earth feature shows the project 
area with the traces superimposed into the window. The user may view the traces and project from 
any view or angle. For this feature to be used, the operating computer must have Google Earth 
installed. 
 

Figure 68:  An example of the Excel PRI template 

Formatted: Justified, Indent: Left:  0", First line:  0", Space
After:  0 pt



 

59 
 

Exporting GPX 
The GPX coordinates can be exported into a format that describes the locations of the defect stations.  
The GPS coordinates of the defect can be viewed through the defect start station, defect end station 
or the defect peak station. Specific runs can be chosen to retrieve the GPS coordinates by adjusting 
the drop down menu under the title, “Select Run to Export.”  
Under the title of Data to Export there are multiple check boxes. In order to export the defect’s GPS 
coordinates, the All Raw GPS locations check box must not be checked. Once the All Raw GPS 
Locations box is deselected, the options to export the defect stationing GPS coordinates become 
available.  
 
 

Troubleshooting 
 
Profiler Hardware Not Found 
Check the serial port connection from the profiler to the computer. Check that the profiler has power 
and is charged. If software disconnects from hardware, close SSI Profiler and reopen the program with 
the profiler powered on. If problem persists, close the program and shut the power off to the profiler. 
Wait five seconds then turn the power to the profiler on. Then open the SSI Profiler program. If the 
issue is not solved, contact SSI customer support.  
 
Distance or Height Readout is not Accurate 
Check the calibration of the device through the collect window, calibrate, and calibration summary. If 
necessary recalibrate the distance or height of the device. It does not happen frequently, but in some 
cases the distance encoder shaft does slips on the axle. In this case, tighten the coupler within the 
machine. If unsure about the steps, contact SSI Customer Support 
 
Do Not Replace the Device Components with Store Bought Items 
Surface Systems and Instruments designs and manufactures their custom built profilers in house. 
Replacing damaged parts that are inadequate will adversely affect the ability to collect accurate 
profiles. Please contact SSI for replacement parts.  
 
Updating the Software 
If your SSI Profiler license has expired, you will not be able to update. Contact SSI to renew your license 
and receive new software updates.   
 


